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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition, visit the 
HP Quality Center Add-ins site:

From the main Quality Center window, select Help > Add-ins Page.

Additional HP Quality Center documentation is also available by visiting the following URL:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.You will also 
receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
3



Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. 
As a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome

Welcome to HP Change Impact Testing module for SAP applications, which 
integrates SAP application entities with Quality Center. Using Change 
Impact Testing, you can track the SAP application entities that are impacted 
by each change you make to an SAP application. This enables you to run 
tests associated with the affected application entities for each change made 
to an SAP application.

Note: This guide explains how to work with SAP Solutions in conjunction 
with Quality Center. For additional information on using Quality Center, 
refer to the HP Quality Center User Guide.

How This Guide is Organized

This guide contains the following chapters:

Chapter 1 Setting Up Change Impact Testing

Describes how to install and enable Change Impact Testing.

Chapter 2 The Change Impact Testing Workflow

Describes the steps performed when testing the impact of changes on an 
SAP application.
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Welcome to This Guide
Chapter 3 Working with the Application Model Module

Describes how to import and manage application entities in the Application 
Model module.

Chapter 4 Testing Change Impact

Describes how to import changes to Quality Center and to analyze their 
impact. Also describes how to create test sets for testing the impact of these 
changes.

Chapter 5 Customizing Change Impact Testing

Describes how to customize permissions and project entities for Change 
Impact Testing.
8
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1
Setting Up Change Impact Testing

This chapter describes the installation requirements and setup procedures 
for using Change Impact Testing.

This chapter includes:

 ➤  Requirements for Change Impact Testing on page 9

 ➤  The Installation Process on page 10

 ➤  Installing Change Impact Testing on page 11

 ➤  Starting the Change Impact Analysis Server on page 24

 ➤  Loading the Change Impact Testing License on page 25

 ➤  Enabling the Change Impact Testing Extension on page 26

 ➤  Configuring SAP Authorizations on page 27

 ➤  Installing the SAP Application Importer Component on page 28

 ➤  Uninstalling Change Impact Testing on page 29

Requirements for Change Impact Testing

To use Change Impact Testing, you must have the following installed:

➤ Quality Center 10.00 Enterprise Edition, or Quality Center 10.00 Premier 
Edition (on your server machine)

➤ SAP R/3 4.6C, R/3 Enterprise 4.70, or ECC 6.0 with SAP Java Connector 
(SAP JCo) 2.1.8

The system requirements to run Change Impact Testing are the same as for 
Quality Center, as described in the HP Quality Center Installation Guide.
9



Chapter 1 • Setting Up Change Impact Testing
The Installation Process

This section describes the Change Impact Testing installation process.

To install Change Impact Testing:

 1 Ensure that Quality Center 10.00 is installed on your server machine.

For more information on installing Quality Center, refer to the 
HP Quality Center Installation Guide.

If you are upgrading from a previous version of Quality Center, you should 
upgrade your Quality Center projects only after you install Change Impact 
Testing.

 2 Install Change Impact Testing on your server machine.

For more information on installing Change Impact Testing, see “Installing 
Change Impact Testing” on page 11.

 3 Install SAP Java Connector (SAP JCo). From the SAP Service Marketplace 
(http://service.sap.com), download SAP JCo 2.1.8 suitable to your platform, 
and install it using the instructions described in the SAP JCo readme. 

When the installation is complete, copy the file sapjco.jar from the SAP JCo 
installation directory to <Change Impact Testing installation 
directory>\CIA. If you installed Change Impact Testing on a Windows 
machine, you must also copy the file sapjcorfc.dll from the SAP JCo 
installation directory to <Windows installation directory>\system32.

 4 Start the Change Impact Analysis server.

For more information, see “Starting the Change Impact Analysis Server” on 
page 24.

 5 Load the Change Impact Testing license.

For more information, see “Loading the Change Impact Testing License” on 
page 25.

 6 Enable the Change Impact Testing extension in Quality Center Site 
Administration for every project that requires Change Impact Testing.

For more information, see “Enabling the Change Impact Testing Extension” 
on page 26.
10
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Chapter 1 • Setting Up Change Impact Testing
 7 Install the SAP Application Importer Component on each client machine.

The Application Model module is installed automatically when you install 
Change Impact Testing. To import application entities from your SAP 
application to the Application Model module, the SAP Application Importer 
Component must be installed on each client machine from which you want 
to import application entities. For more information on installing the SAP 
Application Importer Component, see “Installing the SAP Application 
Importer Component” on page 28.

Installing Change Impact Testing

This section describes how to install Change Impact Testing on your 
Quality Center server machine.

To install Change Impact Testing:

 1 From your Change Impact Testing DVD, run the suitable installation file.

Platform To install:

Windows Run the setup_win.exe file.

Solaris, Linux, AIX, 
or HP-UX
(console mode)

To install on a Solaris platform, type:
./setup_solaris -console 

To install on a Linux platform, type:
./setup_linux -console

To install on an AIX platform, type:
./setup_aix -console

To install on an HP-UX platform, type:
./setup_hpux -console

Note: The console mode installation contains the same 
text and prompts as the UI mode installation. The text 
and prompts are displayed in text mode.
11
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Chapter 1 • Setting Up Change Impact Testing
 2 If you are installing over a previous version of Change Impact Testing, a 
message is displayed recommending that you back up any custom 
configurations before continuing.

 3 The Welcome dialog box opens. Click Next.

Platform To install:

Solaris, Linux, AIX, 
or HP-UX
(UI mode)

➤ Make sure that the DISPLAY environment variable is 
properly configured on the Quality Center host 
computer, and that the computer from which you are 
installing is running an X-server. 

For example, to configure the DISPLAY environment 
variable for TCShell: 

1 Run an X-server (such as Exceed) on your client 
machine.

2 Login into the server machine.

3 Run the tcsh command to enter the TCShell.

4 At the command line prompt enter setenv DISPLAY 
1.1.1.1:0.0, where 1.1.1.1 is the IP address of the cli-
ent machine running the X-server.

5 Navigate to the DVD root directory.

➤ To install on a Solaris platform, type:
./setup_solaris.bin

➤ To install on a Linux platform, type:
./setup_linux.bin

➤ To install on an AIX platform, type:
./setup_aix.bin

➤ To install on an HP-UX platform, type:
./setup_hpux.bin
12
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Chapter 1 • Setting Up Change Impact Testing
 4 The License Agreement dialog box opens.

Read the license agreement. To accept the terms of the license agreement, 
select I accept the terms of the license agreement.

Click Next.
13
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Chapter 1 • Setting Up Change Impact Testing
 5 The Directory Name dialog box opens.

Accept the proposed folder for the Change Impact Testing installation or 
browse for an alternate folder.

Click Next.
14
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Chapter 1 • Setting Up Change Impact Testing
 6 The HP Quality Center Repository Path dialog box opens.

Type the location of the Quality Center repository.

Click Next.
15
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Chapter 1 • Setting Up Change Impact Testing
 7 The Select Which Product to Install dialog box opens.

Select whether to install only Change Impact Testing, or Change Impact 
Testing together with other Quality Center extensions:

➤ To install only Change Impact Testing, select Change Impact Testing 
2.50.

➤ To install Change Impact Testing together with other Quality Center 
extensions, select Multiple Installation.

Click Next.
16
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Chapter 1 • Setting Up Change Impact Testing
 8 If you chose Multiple Installations, the Select Which Products to Install 
dialog box opens.

Select the extensions that you want to install, and click Next. 

For information on other extensions, see the documentation for the 
relevant extension.
17
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Chapter 1 • Setting Up Change Impact Testing
 9 The Installation Summary dialog box opens.

To review or change any settings, click Back.

To accept the settings and start the installation, click Next. The installation 
process starts.
18
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Chapter 1 • Setting Up Change Impact Testing
 10 When the installation process completes, the Update the Server dialog box 
opens.

When you update the Quality Center server, the Change Impact Testing files 
are copied into the opened archive in the <Quality Center Installation>
\application\qcbin.war directory. The Quality Center Archive and 
Deployment Tool is launched. This tool enables you to update the running 
Quality Center Web server.

Select an update option:

➤ Update now. Automatically updates the Quality Center archive files and 
runs the deployment tool.

➤ Update later. Enables you to manually update the Quality Center server 
at a later time. You must update the Quality Center server before you can 
use Change Impact Testing.

Click Next. 
19
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Chapter 1 • Setting Up Change Impact Testing
 11 If you selected Update now, proceed to step 12.

If you selected Update later, click Next and then click Finish to close the 
installation setup dialog box. When you are ready to update the application 
server, run the deploy.bat script (or deploy.sh for non-Windows systems) 
from the <Change Impact Testing installation> directory. When running the 
batch file, specify the Quality Center installation directory and the location 
of the Quality Center repository, using the format:

deploy <Quality Center installation directory> <Quality Center repository 
directory>

For example:

deploy "C:\Program Files\HP\Quality Center" "C:\Program Files\HP\
Quality Center\repository"

 12 After clicking Update now or manually launching the batch file, the 
Quality Center Archive and Deployment Tool opens.

For Change Impact Testing to work with Quality Center, you need to create 
a new archive and redeploy the qcbin.war file on the application server. This 
enables changes to the archive file to take effect.

Click Next to create the new archive file.
20
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Chapter 1 • Setting Up Change Impact Testing
 13 If your application server is JBoss, proceed to step 14.

If your application server is WebSphere or WebLogic, the following dialog 
box opens.

You must deploy Quality Center manually on the application server after 
the setup process completes. The location of the archive file is shown in the 
dialog box. 

Note: For more information on manually deploying Quality Center on an 
application server, refer to the HP Quality Center Installation Guide.

Click Next and proceed to step 16.
21
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Chapter 1 • Setting Up Change Impact Testing
 14 If your application server is JBoss, the HP Quality Center Redeployment 
dialog box opens.

Choose one of the following options:

➤ Yes. To deploy the archive files automatically.

➤ No. To manually deploy the archive files later.

Click Next.
22
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Chapter 1 • Setting Up Change Impact Testing
 15 If the Quality Center service is running, the Archive and Deployment Tool 
automatically attempts to stop the service. If the tool is unable to stop the 
service, the Service Not Stopped dialog box opens.

Choose one of the following options:

➤ Retry. Instructs the setup program to try to stop the JBoss service again.

➤ Skip JBoss deployment. Instructs the setup program to cancel the 
deployment. You must manually deploy JBoss later.

Click Next.

 16 When the deployment is complete, the Completion dialog box opens. Click 
Finish to close the Quality Center Archive and Deployment Tool.

Note: If you manually deployed the archive files on your application server, 
you must restart Quality Center after deployment.

 17 Click Finish to close the HP quality process for SAP applications Setup dialog 
box.
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Chapter 1 • Setting Up Change Impact Testing
Starting the Change Impact Analysis Server

After you have installed Change Impact Testing, you start the Change 
Impact Analysis server. The Change Impact Analysis server imports SAP 
application changes and analyzes their impact on your SAP application 
entities.

Note: You must have the SAP Java Component installed to import changes 
using the Change Impact Analysis server. For more information on 
installing this component, see “The Installation Process” on page 10.

To start the Change Impact Analysis server:

 1 On your Quality Center server machine, open a command prompt window.

 2 Navigate to <Change Impact Testing installation directory>\CIA.

 3 Run the file appropriate for your platform:

Important: To ensure that the Change Impact Analysis server keeps running, 
you must keep the command prompt window open, and the user who 
started the server must remain logged on. Alternatively, the batch file can be 
run as a service using any available third-party tool.

Platform To install:

Windows Run the Run_CIA_Server.bat file.

Solaris, Linux, AIX, 
or HP-UX

Run the Run_CIA_Server.sh file.
24
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Chapter 1 • Setting Up Change Impact Testing
Loading the Change Impact Testing License

To enable Change Impact Testing in Quality Center, you must load your 
Change Impact Testing license.

To load the Change Impact Testing license:

 1 In Site Administration, click the Licenses tab.

 2 Click the Modify License button. The License Edit dialog box opens.

 3 Click the Load License button and select the Change Impact Testing license 
file. Alternatively, copy the license file and click Paste License.

 4 Click OK. The license is displayed in the list of licenses.
25
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Enabling the Change Impact Testing Extension

After installing Change Impact Testing on your Quality Center server, you 
must enable the Change Impact Testing extension for a project before you 
can use it with the project.

Before enabling the Change Impact Testing extension, consider the 
following points:

➤ You cannot disable an extension for a project after you enable it.

➤ When you enable a project for Change Impact Testing, the Application 
Model module and Changes module are enabled for the project.

➤ If the project is active, you must deactivate it before enabling an extension. 
After the extension has been enabled, you can reactivate the project.

➤ Enabling extensions for a project can take some time.

To enable the Change Impact Testing extension for a project:

 1 In Quality Center Site Administration, click the Site Projects tab.

 2 If relevant, create a new project in Quality Center in which to enable the 
extension. For more information on creating Quality Center projects, refer 
to the HP Quality Center Administrator Guide.

 3 In the Projects list, select a project. In the right pane, click the Project 
Extensions tab. The Extensions list is displayed, listing extensions installed 
on the Quality Center server for which you have a license.
26
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Chapter 1 • Setting Up Change Impact Testing
 4 Select the Enabled check box for the Change Impact Testing for SAP 
applications extension, and click Yes to confirm. The Change Impact 
Testing for SAP applications and Application Model extensions are both 
enabled and a confirmation message displays.

Configuring SAP Authorizations

To work with Change Impact Testing, you must configure an SAP user role 
with the appropriate authorization objects. You then assign the properties of 
this SAP user role to the SAP user who will be logging in to the SAP server to 
import changes. 

The following is the minimal set of authorization objects that must be 
configured for this SAP user role:

➤ S_RFC (Authorization Check for RFC Access). Grants permission to execute 
certain Remote Function Calls (RFCs)

The following function groups require execution permissions:

➤ SYST. A set of functions that provide basic connection tasks.

➤ SDTX. Contains a single function (RFC_READ_TABLE) that provides 
external access to R/3 tables.

➤ SEU_COMPONENT. An interface to the application components 
hierarchy, used when importing the application hierarchy.

The following function groups require execution permissions if you want to 
import SAP Solution Manager business blueprints:

➤ SA_KW_RFC. An interface to the document repository.

➤ SCUT. An interface to ABAP.

➤ SIFP. An interface to program objects.

➤ S_TABU_DIS (Table Maintenance). Grants permission to view R/3 tables.
27
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Chapter 1 • Setting Up Change Impact Testing
Installing the SAP Application Importer Component

You must install the SAP Application Importer Component on each 
Quality Center client machine on which you want to import SAP 
application entity hierarchies to the Application Model module. The SAP 
Application Importer Component is the tool that communicates with the 
SAP server and imports application entity data from your SAP application to 
Quality Center.

Notes: 

➤ To install the SAP Application Importer Component, you must have 
Microsoft .NET Framework 2.0 installed on the client machine. You can 
download these from the Microsoft Web site 
(http://www.microsoft.com).

➤ To install the SAP Application Importer Component, you must have 
operating system administrator permissions.

To install the SAP Application Importer Component:

 1 From your Quality Center client machine, log in to a project for which 
Change Impact Testing is enabled. The SAP Application Importer 
Component files are downloaded to your client machine.

 2 Locate the APM directory in the Quality Center installation directory (by 
default C:\Program Files\Common Files\Mercury Interactive\
Quality Center).

 3 Run the SAPAppImporterSetup.exe file located in this folder and follow the 
installation instructions on your screen.
28

28



Chapter 1 • Setting Up Change Impact Testing
Uninstalling Change Impact Testing

This section describes how to uninstall Change Impact Testing from your 
server machine. When you uninstall Change Impact Testing, the Change 
Impact Testing files are deleted from Quality Center.

This section includes the following topics:

➤ Uninstalling Change Impact Testing from Windows

➤ Uninstalling Change Impact Testing from Non-Windows Systems

Uninstalling Change Impact Testing from Windows
This section describes how to uninstall Change Impact Testing from 
Windows.

To uninstall Change Impact Testing from Windows:

 1 Make sure that the application server is running.

 2 To open the HP Quality Process for SAP Solutions Uninstall dialog box, you 
can:

➤ Choose Start > Settings > Control Panel > Add/Remove Programs, select 
HP Quality Process for SAP Solutions, and click the Change/Remove 
button. Follow the instructions on your screen.

➤ Locate the Change Impact Testing home directory. By default, the files 
are stored in [drive]:\Program Files\HP\Quality Process for SAP Solutions. In 
the _uninst subdirectory, double-click uninstall.exe.

The HP Quality Process for SAP Solutions Uninstall dialog box opens.
29
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Chapter 1 • Setting Up Change Impact Testing
 3 Click Next. The Update the Server dialog box opens.

Select an update option:

➤ Yes. To update the archive files and launch the deployment tool now.

➤ No. To update and uninstall later.

Click Next to continue to uninstall, or Cancel to uninstall later.
30
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Chapter 1 • Setting Up Change Impact Testing
 4 The Quality Center Archive and Deployment Tool opens.

To uninstall Change Impact Testing, you need to create a new archive and 
redeploy qcbin.war on the application server. This enables changes to the 
file to take effect.

Click Next to create the new archive files.
31
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Chapter 1 • Setting Up Change Impact Testing
 5 If your application server is JBoss, proceed to step 6.

If your application server is other than JBoss, the following dialog box 
opens.

You must deploy Quality Center manually on the application server after 
the setup process completes. The location of the archive file is shown in the 
dialog box. 

The updated archive file is stored in different formats, although the content 
is the same. The files are stored in the 20qcbin.war folder, and are archived 
in qcbin.war.

To update the archives and undeploy them manually, run the undeploy.bat 
script from the <Change Impact Testing installation> directory. When 
running the batch file, specify the Quality Center installation directory and 
the location of the Quality Center repository, using the format:

undeploy <Quality Center installation directory> <Quality Center repository 
directory>
32

32



Chapter 1 • Setting Up Change Impact Testing
For example:

undeploy "C:\Program Files\HP\Quality Center" "C:\Program Files\HP\
Quality Center\repository"

Note: For more information on manually deploying Quality Center on an 
application server, refer to the HP Quality Center Installation Guide.

Click Next and proceed to step 8.

 6 If your application server is other than JBoss, proceed to step 8.

If your application server is JBoss, the HP Quality Center Redeployment 
dialog box opens.

Choose one of the following options:

➤ Yes. To deploy the archive files automatically.

➤ No. To manually deploy the archive files later. 

Click Next to continue.
33
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Chapter 1 • Setting Up Change Impact Testing
 7 If the Quality Center service is running, the Archive and Deployment Tool 
automatically attempts to stop the service. If the tool is unable to stop the 
service, the Service Not Stopped dialog box opens.

Choose one of the following options:

➤ Retry. To try again to stop the JBoss service.

➤ Skip JBoss deployment. To cancel the deployment and manually deploy 
JBoss later.

Click Next.

 8 When the deployment is complete, the Completion dialog box opens. Click 
Finish to close the Quality Center Archive and Deployment Tool Setup. The 
HP Quality Process for SAP Solutions Uninstall dialog box is displayed.

 9 Click Next. The Update completed dialog box opens.
34

34



Chapter 1 • Setting Up Change Impact Testing
 10 Click Next to continue. The File Deletion dialog box opens.

Select Yes to delete the remaining uninstall files in the Change Impact 
Testing directory.

Click Next.

 11 Click Finish to close the HP Quality Process for SAP Solutions Uninstall 
dialog box.

Uninstalling Change Impact Testing from Non-Windows 
Systems
This section describes how to uninstall Change Impact Testing from non-
Windows systems, such as Linux or Solaris.

To uninstall Change Impact Testing from non-Windows systems:

 1 Run the Quality Center Archive and Deployment Tool to create a new 
archive and redeploy the Quality Center .war file on the application server.
35
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To update the archives and undeploy them manually, run the undeploy.sh 
script from the <Change Impact Testing installation> directory. When 
running the batch file, specify the Quality Center installation directory and 
the location of the Quality Center repository, using the format:

undeploy <Quality Center installation directory> <Quality Center repository 
directory>

 2 Make sure that the application server is running.

 3 Type the following command at the system prompt:

/[directory]/[Change Impact Testing_directory]/_uninst/uninstall

The HP Quality Process for SAP Solutions Uninstall wizard opens.

 4 Click Next. Follow the on-screen instructions.

 5 When you are prompted to delete all add-in files, select Yes.
36
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2
The Change Impact Testing Workflow

After you have installed and enabled Change Impact Testing, you can use it 
to analyze the impact of changes to an SAP application, and create and run 
test sets to test this impact.

Change impact testing includes the following stages. 

D efine  A pp lica tion  
E n tities

A ssoc ia te  A pp lica tion  
E n tities  w ith  Tests  and
B us iness C om ponen ts

A na lyze
C hanges

C rea te
Tes t S e ts

R un
Tes t S e ts

Im port
C hanges
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Chapter 2 • The Change Impact Testing Workflow
Defining Application Entities

You first define which application entities (SAP transactions and batch jobs) 
to include in the scope for the change impact analysis. Only entities that 
you include in the scope at this stage are included in the change impact 
analysis. You can import the application entities hierarchy from your SAP 
application or define application entities manually. Entities that you define 
manually are not included in the change impact analysis.

For more information on defining application entities, see Chapter 3, 
“Working with the Application Model Module.”

Associating Application Entities with Tests and Business 
Components

After you define which application entities are included in the scope, you 
associate them with tests by creating test coverage for each application 
entity. When you create a test set to test a change made to your SAP 
application, the tests associated with the application entities affected by the 
change form the basis for the test set.

You can associate application entities with existing tests located in the Test 
Plan module. Alternatively, you can create new tests specifically for the 
purpose of covering application entities from the Test Plan module.

For more information on associating application entities with tests, see 
“Associating Application Entities with Tests” on page 52.

If you are working with Business Process Testing, you can also associate 
application entities with business components. For more information, see 
“Associating Application Entities with Business Components” on page 56.
38
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Importing Changes

After you define which application entities are included in scope, and 
associate them with tests, you import the SAP application changes to your 
Quality Center project. You first select which changes you want to import. 
The selected changes are then imported into the Changes module.

For more information on importing changes, see “Importing Changes” on 
page 64.

Analyzing Changes

After you import your changes to the Changes module, you select which 
changes you want to analyze. Change Impact Testing then analyzes these 
changes and determines which in-scope application entities they affect.

For more information on analyzing changes, see “Analyzing Changes” on 
page 66.

Creating Test Sets

After you analyze your changes, you create a test set to test the impact of all 
or some of the changes. You select the tests to include in the test set from 
the tests associated with application entities that are affected by the 
changes.

For more information on creating test sets, see “Creating Test Sets” on 
page 73.
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Running Tests Sets

After you create your test sets to test the impact of changes made to your 
SAP application, you run them and record their results in the Quality Center 
Test Lab module. You can then analyze the results of the tests using 
Quality Center graphs, reports, and documents.

After you run your test sets and analyze their results, you can begin the next 
test cycle by importing new changes and reanalyzing existing changes if 
necessary. There is no need to redefine the application entities that are 
included in scope for the change impact analysis. You also do not need to 
recreate associations with tests.

For more information on running test sets and analyzing their results, see 
the HP Quality Center User Guide.
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3
Working with the Application Model 
Module

The Application Model module enables you to manage a hierarchical 
representation of the entities in your SAP application. You can import 
entities from your SAP application, and add and modify application entities 
and folders. You can also associate application entities with tests or business 
components.

This chapter includes:

➤ About Working with the Application Model Module on page 42

➤ Viewing Application Entities on page 43

➤ Importing the SAP Application Hierarchy on page 45

➤ Adding Folders and Application Entities Manually on page 48

➤ Modifying Folders and Application Entities on page 50

➤ Associating Application Entities with Tests on page 52

➤ Associating Application Entities with Business Components on page 56
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About Working with the Application Model Module

Before you analyze changes, you must decide which SAP components and 
application entities in your SAP application are analyzed for change impact. 
You define this scope in the Application Model module, which contains a 
representation of your SAP components and application entities in the 
application model tree. When you analyze your SAP application changes, 
the application entities that you include in scope at this stage are included 
in the change impact analysis. For more details on analyzing changes, see 
"About Testing Change Impact" on page 60.

You can import SAP components and application entities from your SAP 
application.When you import directly from your SAP application, the 
hierarchy of the elements in the application and the basic data for each 
business entity are preserved. If you want to extend the scope at any stage, 
you can import the application hierarchy again, without overwriting 
existing entities in the Application Model module.  

You can also manually add and modify application entities in the 
Application Model module. Note that this does not affect corresponding 
application entities in your SAP application and application entities added 
manually are not included in the change impact analysis.

After you develop your application model tree, you can associate each 
application entity with tests in the Test Plan module. This is important 
when changes are made to your application entities, as it enables you to see 
which tests you need to run to test the impact of each change. If your 
Quality Center server is licensed for Business Process Testing, you can also 
associate an application entity with a business component. Each business 
process test containing that business component is then associated with all 
of the application entities associated with that component.
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Viewing Application Entities

You import, add, and modify application entities using the Application 
Model module. To open the Application Model module, click the 
Application Model button on the sidebar. 

You can view your application entities in The Application Model Tree or the 
The Application Model Grid.

The Application Model Tree
You can view a hierarchical representation of your application entities in the 
application model tree. To view the application model tree, select View > 
Application Model Tree.

By default, each folder  in the application model tree represents an SAP 
application component in your SAP application. During the Learn Flow 
process, a folder with the name of the flow is created for any flow 
representing a transaction whose application entity is not in the application 
model tree. Each application entity  represents an application entity in 
your SAP application.
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The Application Model Grid
You can view all the application entities in a Quality Center project from the 
Application Model Grid. Each row displays a separate application entity. 
Each column represents a separate data item. To view the Application Model 
Grid, select View > Application Model Grid. 

The following columns are displayed for each entity:

Column Description

Code The code of the entity in the SAP application.

Description The description of the entity in the SAP application.

Entity ID A unique numerical ID assigned by Quality Center to the 
application entity. This ID cannot be modified.

Entity Name The name of the entity in the SAP application.

Folder The folder in the application model tree in which the 
application entity is located. Each folder represents an 
SAP application element. 

Is Active If this column is set to “Y”, the application entity is 
included in the scope when analyzing change impact. 
Otherwise, the column is set to “N”, and the application 
entity is not included in the scope. 
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Importing the SAP Application Hierarchy

You can import the application hierarchy to the Application Model module. 
This maps the entities in your SAP application to application entities in the 
Application Model module, reproducing the same hierarchical structure. 
Each SAP application element is represented as a folder. Each folder contains 
representations of the application entities that are included in the SAP 
application element in your SAP application. 

You can import the application hierarchy more than once. For example, if 
you add new entities to your SAP application, you may want to include 
them in the application hierarchy, or you may decide to include application 
entities in the change impact analysis that were previously out of scope. 
When you import application entities that are already in the Application 
Model module, the data that you entered for each application entity is 
preserved. Any associations you created with tests and business components 
are also preserved.

Modified The date and time when the application entity was last 
modified.

Type Indicates whether the application entity is an 
SAP Transaction or SAP Batch Job, or is an entity created 
by Change Impact Testing of type SAP Functional Area or 
SAP Technical Object. 

Column Description
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To import the application hierarchy:

 1 In the Application Model module, display the application model tree and 
select Application Entities > Import Application Model. The Import 
Application Model Wizard dialog box opens.

 2 In the Description field, select your SAP system. The login details are filled 
in automatically. Alternitavely, type the login details for your SAP 
application.

Note: The look-up list in the Description field is populated from the 
saplogon.ini file. Make sure that the SAPLOGON_INI_FILE environment 
variable is defined pointing to the saplogon.ini file.

Click Next. 
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Quality Center connects to your SAP application and the Select 
Application Components dialog box opens, displaying the SAP 
components in your SAP application. (You can view the same hierarchy in 
your SAP application using the SE81 transaction.)

 3 Select the SAP application elements you want to import to the 
Application Model module. When these application components are 
imported, all child application entities are also imported. Click Next.

Note: You can also import user transactions that are not assigned to any 
application component. To import these transactions, select the User 
Transactions (Unassigned) node in the Select Application Components 
dialog box.

 4 Click Import to import the SAP components and application entities to 
the Application Model module. Note that this process may take some 
time. When the import process is finished, a confirmation message 
displays. Click OK.

 5 Click Close to close the Import Application Model Wizard.
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The application components you selected are imported to the Application 
Model module. The hierarchical structure of the SAP application 
components is reproduced in the Application Model module, with the 
top-level components located under the SAP folder.

Note: The Application Model module may also contain entities that do not 
correspond directly to entities in your SAP application. These entities, which 
may be created when you import changes, are located under the SAP 
Extended folder. For more information on these entities, see "About Testing 
Change Impact" on page 60.

When you import application entities to the Application Model module, 
a default value is assigned to the Is Active field for each imported 
application entity. This default value is based on the properties of the 
entity in the SAP application. You can change this value manually after 
the import. The application entity will only be included in scope for the 
change impact analysis if this field is set to “Y”. 

Adding Folders and Application Entities Manually

You can add folder and application entities manually.

Tip: You can also import folders and application entities using the Import 
Application Model Wizard. For more information, see "Importing the SAP 
Application Hierarchy" on page 45.
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To add a folder:

 1 In the application model tree, select a folder and click the New Folder 
button, or select Application Entities > New Folder. The New Folder dialog 
box opens.

 2 In the Folder Name box, type a name for the folder and click OK. The new 
folder is added to the application model tree under the folder you selected 
in step 1.

 3 You can add a description for the new folder in the Description tab in the 
right pane.

 4 You can add an attachment to the new folder in the Attachments tab. For 
more information on adding attachments, see the HP Quality Center User 
Guide.

To add an application entity:

 1 In the application model tree, select a folder and click the New Entity 
button, or select Application Entities > New Entity. The New Application 
Entity dialog box opens.
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 2 In the Application Entity Name box, type the name of the application 
entity. This is a required field.

 3 In the Application Entity Code box, type the unique code of the 
application entity. This is a required field.

 4 In the Description box, type a description of the application entity.

 5 Click OK. The new application entity is added to the application model 
tree under the folder you selected in step 1.

Modifying Folders and Application Entities

You can rename and delete folders and application entities in the 
Application Model module.

Renaming Folders and Application Entities
You can rename a folder or application entity in the Application Model 
module.

To rename a folder or application entity:

➤ To rename a folder or application entity in the application model tree, 
select a folder or application entity and select Edit > Rename. 
Alternatively, right-click the folder or application entity and select 
Rename. Edit the name and press ENTER.

➤ To rename an application entity in the Application Model Grid, click the 
name of the application entity and type the new name.
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Deleting Folders and Application Entities
You can delete a folder or application entity from the application model 
tree. When you delete a folder, you can choose to delete the folder and its 
subfolders, or you can choose to delete the folder, its subfolders, and 
application entities. 

➤ If you delete a folder with its subfolders, all of the application entities are 
moved to the Unattached folder in the application model tree. 

➤ If you delete a folder with its subfolders and application entities, all 
subfolders and application entities under the selected folder are deleted 
permanently. 

To delete a folder:

 1 Select a folder from the application model tree.

 2 Click the Delete button, or select Edit > Delete. Alternatively, right-click 
the folder and select Delete. The Confirm Delete Folder dialog box opens.

 3 Select Delete folders only or Delete folders and application entities.

 4 Click Yes.

To delete an application entity:

 1 Select an application entity from the application model tree or 
Application Model Grid.

 2 Click the Delete button, or select Edit > Delete. Alternatively, right-click 
the application entity and select Delete.

 3 Click Yes to confirm.
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Associating Application Entities with Tests 

You can associate the application entities you created in the Application 
Model module with tests from the Test Plan module. You can add tests using 
the Application Model module or the Test Plan module.

Associating Application Entities Using the Application 
Model Module
You can associate application entities with tests using the Application Model 
module.

To associate application entities with tests using the Application Model 
module:

 1 In the application model tree, select an application entity and click the 
Linked Tests tab. The Linked Tests tab displays the coverage grid for the 
selected application entity.

For information on the columns in the Linked Tests tab, see the 
HP Quality Center User Guide.
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 2 In the Linked Tests tab, click the Select Tests button to show the test plan 
tree on the right.

 3 To search for a specific test in the tree, type the name (or part of the 
name) of the test in the Find box and click the Find button. If the search is 
successful, the test is highlighted in the tree.

 4 To refresh all of the tests in the test plan tree, click the Refresh All button.

 5 Select a test or test folder to add to the application entity’s test coverage. 
Click the Link Tests To Application Entity button. The test is added to the 
coverage grid.

 6 To refresh the application entities in the coverage grid, click the Refresh 
All button above the grid. 

 7 To filter the application entities displayed in the coverage grid, choose 
one of the following options from the Show Entities box:

➤ Linked Directly. Displays those tests that are associated directly with 
the application entity.

➤ Linked Through Other Assets. Displays those tests that are associated 
with the application entity via business components.

➤ All. Displays all of the application entities that are associated with the 
test. 
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 8 Click the Close button to hide the test plan tree.

Notes: 

➤ To modify the data in the coverage grid columns or to remove tests 
from the coverage grid, you must first select Linked Directly in the 
Show Entities box.

➤ To remove test coverage from the Application Model module, verify 
that Linked Directly is displayed in the Show Entities box. Then select 
the test you want to remove from coverage and click the Remove Link 
button. Click Yes to confirm.

Associating Application Entities Using the Test Plan 
Module
You can associate application entities with tests using the Test Plan module.

To associate application entities with tests using the Test Plan module:

 1 In the test plan tree, select the test you want to associate with one or more 
entities, and click the Application Entities tab. The application entities 
associated with the selected test are displayed.
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 2 In the Application Entities tab, click the Select Application Entities button 
to show the application model tree on the right.

 3 To search for a specific application entity in the tree, type the name (or 
part of the name) of the application entity in the Find box and click the 
Find button. If the search is successful, the application entity is 
highlighted in the tree.

 4 To refresh all of the application entities in the application model tree, 
click the Refresh All button.

 5 Select an application entity or application folder to add to the test’s 
application entity coverage. Click the Add Entity to Linkage button. The 
application entity is added to the coverage grid.

 6 To refresh the application entities in the coverage grid, click the Refresh 
All button above the grid.

 7 To filter the application entities displayed in the coverage grid, choose 
one of the following options from the Show Entities box:

➤ Linked Directly. Displays those application entities that are 
associated directly with the test.

➤ Linked Through Other Assets. Displays those application entities 
that are associated with business components via business process 
tests.

➤ All. Displays all of the application entities that are associated with 
the test. 
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 8 Click the Close button to hide the application model tree.

Notes: 

➤ To modify the data in the coverage grid columns or to remove 
application entities from the coverage grid, you must first select Linked 
Directly in the Show Entities box.

➤ To remove application entity coverage from the Test Plan module, 
verify that Linked Directly is displayed in the Show Entities box. Then 
select the application entity you want to remove from coverage and 
click the Remove Link button. Click Yes to confirm.

Associating Application Entities with Business Components

You can associate an SAP entity with any type of test, including a business 
process test. To associate an entity with a business process test, you first 
associate the entity with one or more business components. Then, when 
you include these business components in a business process test, the test is 
automatically associated with the entities that are a part of the business 
process test’s business components. For details on adding business 
components to a business process test, see the HP Business Process Testing 
User Guide.

You associate application entities with business components using the 
Business Components module. After they are associated, you can manage 
your associated application entities either from the Application Model 
module or from the Business Components module.

To manually associate application entities with business components:

 1 In the component tree, select the component you want to associate with 
one or more application entities, and click the Application Entities tab. 
The application entities associated with the selected business component 
are displayed. For a description of each column displayed, see "The 
Application Model Grid" on page 44.
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 2 In the Application Entities tab, click the Select Application Entities button 
to show the application model tree on the right.

 3 To search for a specific application entity in the tree, type the name (or 
part of the name) of the application entity in the Find box and click the 
Find button. If the search is successful, the application entity is 
highlighted in the tree.

 4 To refresh all of the application entities in the application model tree, 
click the Refresh All button.

 5 Select an application entity or application folder to add to the business 
component’s application entity coverage. Click the Add Entity to Linkage 
button. The test is added to the coverage grid.

 6 Click the Close button to hide the application model tree.

Note: To remove application entity associations from the Business 
Components module, select the application entity for which you want to 
remove an association, click the Remove Link button, and click Yes to 
confirm.
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4
Testing Change Impact

After you have defined which application entities are included in scope and 
associated them with tests, you can import changes to your SAP application 
and analyze their impact. You can then create test sets to test the impact of 
these changes.

This chapter includes:

 ➤  About Testing Change Impact on page 60

 ➤  Viewing Changes on page 61

 ➤  Importing Changes on page 64

 ➤  Analyzing Changes on page 66

 ➤  Viewing Testing Impact on page 69

 ➤  Modifying Folders and Change Entities on page 71

 ➤  Creating Test Sets on page 73
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About Testing Change Impact

After you define in the Application Model module which application 
entities are included in scope for the change impact analysis, you can 
import the changes to the Changes module. You can then analyze these 
changes.

The only impact included in the analysis is the impact on application 
entities that are included in the Application Model module with the 
Is Active field assigned value “Y”. In addition, the impact to user 
transactions is included, even if the user transactions are not included in the 
Application Model module. If such a user transaction is affected by an 
imported change, it is added to the Application Model module.

Note: In addition to the entities included in the Application Model module 
that correspond directly to entities in your SAP application (of type SAP 
Transaction and SAP Batch Job), other entities may be created that do not 
exist as entities in your SAP application. These are created under the SAP 
Extended folder and can be of two types:

➤ Functional Area. These are entities that are applicable across different 
application areas. An example of such an entity may be Pricing, as most 
business functionality affects pricing in some way.

➤ Technical Object. These are physical workbench entities from the SAP 
environment, such as programs and function pools. These entities are 
only created if the impact is not already recorded on another entity.

For each change, you can view which application entities are impacted. You 
can also view which tests are needed to test the impact of each change, 
based on the associations you created between application entities and tests. 
You can then create a test set containing some or all of these tests. After you 
create the test set, you can run it and analyze its results to evaluate the 
impact of the changes on your SAP application.
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Viewing Changes

You view your SAP application changes using the Changes module. To open 
the Changes module, click the Changes button on the sidebar. 

You can view your change entities in the changes tree or the Changes Grid.

The Changes Tree
You can view a hierarchical representation of your application changes in 
the changes tree. To view the changes tree, choose View > Changes Tree.

Each folder  in the changes tree can contain changes and other folders. 
Each change icon  represents a change in your SAP application. A change 
icon with a red arrow  represents a change that has not been analyzed.
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The Changes Grid
You can view all the application changes in a Quality Center project from 
the Changes Grid. Each row displays a separate application change. Each 
column represents a separate data item. To view the Changes Grid, choose 
View > Changes Grid. 

The following columns are displayed for each change:

Column Description

Analysis Date The time the change impact was performed that 
imported the change.

AUT Client The client name of the SAP application.

AUT Code The change code.

AUT Creation Date The date on which the change was created.

AUT Developer The developer who made the change.

AUT Released Indicates whether the change was released.

AUT System Number The system number of the change.

AUT Target System The target system of the change.
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AUT URI The uniform resource identifier (URI) of the SAP 
application.

Author The Quality Center user who imported the change to the 
Changes module.

Creation Date The date the change was imported to the Changes 
module.

Description A description of the change. Includes a list of SAP objects 
that were modified during the change.

Entity Name The change’s name.

Folder The change folder in which the change is located.

Modified The date and time the change was last modified in 
Quality Center.

Status The current status of the changes. Can have one of the 
following values:

➤ Analyzed (Failed). The changes failed an analysis.

➤ Analyzed (In Progress). The change is currently being 
analyzed.

➤ Analyzed (Passed). The change passed an analysis 
successfully.

➤ Closed. The change has been tested and closed.

➤ Imported. The change was created as a result of an 
import from the SAP application and has not been 
analyzed.

➤ Manual. The change was created manually and has 
not yet been analyzed.

➤ Failed. One or more of the tests associated with the 
change failed.

➤ Passed. All the tests associated with the change 
passed.

➤ Under Test. The change is currently being tested.

Column Description
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Importing Changes

Change Impact Testing enables you to import the changes you made to an 
SAP application into the Changes Module.

To import changes:

 1 In the changes tree, select the folder to which you want to import the 
changes.

 2 Choose Changes > Import Changes. The SAP Login Details dialog box 
opens.
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 3 Type the login details for your SAP application and click Next. 
Quality Center connects to your SAP application and the Select Changes to 
Import dialog box opens.

 4 You can choose to import changes made during a specified date range, or to 
import changes by their transport ID.

➤ Select By Date Range to import changes made during a specified range. 
In the From and To boxes, specify the range for which you want to 
import changes.

➤ Select By Transport IDs to import a single change. Type the transport IDs 
for the changes you want to import. You can type more than one 
transport ID, separating the transport IDs by commas (,) without spaces.

Click Next.
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 5 Click Import. The import process begins.

 6 When the import process is complete, a message box displays and you are 
asked whether you want to analyze the imported changes. Click Yes to 
analyze the imported changes immediately, or No to analyze the imported 
changes at a later stage. For more information on analyzing changes, see 
“Analyzing Changes” on page 66.

The changes you imported are displayed in the changes tree under the 
folder you selected. You can view a summary of the analysis in the Change 
Summary tab, located at the bottom of the Details tab in the Changes 
module. The summary lists the change requests included in the change. For 
each change request, the SAP objects changed are also listed.

Analyzing Changes

After you import the changes made to your SAP application to the Changes 
module, you can analyze the impact of these changes on the SAP 
application entities.

Notes:

➤ When you analyze a change, results from previous analyses are 
overwritten. In addition, any associations that you created manually 
between the change entity and application entities are also overwritten.

➤ You can analyze changes on a different SAP application than the 
application from which they were imported. For example, you can 
import changes from a development SAP application, and analyze the 
changes on the testing application. If the two applications are not 
identical, the analysis may display different results.

To analyze changes:

 1 In the Changes module, select the changes or change folder you want to 
analyze. 
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Note: The load on the Change Impact Analysis server is proportional to the 
complexity of analyzed changes and the amount of changes simultaneously 
sent to analysis. Analyzing a large quantity of changes simultaneously 
might result in a resource overload and could cause the Change Impact 
Analysis server to run out of memory and terminate. Out of Memory errors 
in the Change Impact Analysis server console and logs should be handled in 
one of the following ways:

➤ Increase the value for the Xmx parameter in the Run_CIA_Server batch 
file, and restart the Change Impact Analysis server.

➤ Send smaller groups of changes to the Change Impact Analysis server, 
and wait until the analysis completes before sending the next group.

 2 Choose Changes > Analyze Changes. The Confirm dialog box opens.

 3 Click Yes. The Login to SAP dialog box opens.

 4 Type the login details for your SAP application and click Analyze. The 
changes you selected are analyzed and a confirmation message displays.
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Tip: The change impact analysis is performed in the background. You can 
view the current status of the change impact analysis for a change by 
clicking the Refresh All button to refresh the display and then checking the 
Status field for the change. For more information on the possible values for 
the Status field, see “The Changes Grid” on page 62.

When the analysis is complete for a change, a summary of the analysis is 
added to the Change Summary tab, located at the bottom of the Details tab 
in the Changes module. The summary includes the time and status of the 
analysis, the total number of impacted application entities, and the number 
of impacted application entities not included in scope for the analysis.
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Viewing Testing Impact

Change Impact Testing correlates the objects that were modified as part of 
each imported change with SAP application entities. You can view details of 
the SAP application entities that are impacted by each change.

To view testing impact:

 1 In the changes tree, select a change or change folder and click the Testing 
Impact tab. The application entities affected by the selected change or 
change folder are displayed.

The following columns are displayed for each entity:

Column Description

App.Entity Code The code of the entity in the SAP application.

Application Entity 
Description

The description of the entity in the SAP application.

Application Entity 
Name

The name of the entity in the SAP application. You can 
click the name to go to the entity in the Application 
Model module.
69

69



Chapter 4 • Testing Change Impact
 2 To filter or sort the application entities displayed in the Testing Impact tab, 
click the Set Filter/Sort button. For details on filtering and sorting, refer to 
the HP Quality Center User Guide.

 3 To manually add application entities to the impact, click the Select 
Application Entities button. The application model tree displays in the right 
pane. 

In the right pane, select the application entity you want to add to the 
impact and click the Add Entity to Impact button. The application entity is 
added to the impact.

 4 To remove an application entity from the impact, select the application 
entity and click the Remove Link button. Click Yes to confirm.

Calculating Impact Strength
Change Impact Testing identifies the changed SAP objects that caused the 
application entity to be part of the impact, and calculates their risks. The 
highest risk is taken to be the strength of the impact.

Impact Strength The level of risk that the change poses for the application 
entity. This level is automatically calculated by Change 
Impact Testing. For more information, see “Calculating 
Impact Strength” on page 70.

Is Active If this column has value “Y”, the application entity will 
be included in the scope when analyzing change impact. 
Otherwise, the column has value “N” and the 
application entity is not included in the scope.

Modified The date when the change last impacted the application 
entity.

Type Indicates whether the application entity is an 
SAP Transaction or SAP Batch Job, or is an entity created 
by Change Impact Testing of type SAP Functional Area or 
SAP Technical Object.

Column Description
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The following table describes how Change Impact Testing ranks the 
change’s impact strength:

Modifying Folders and Change Entities

You can rename and delete folders and change entities in the Changes 
module.

Renaming Folders and Change Entities
You can rename a folder or change entity in the Changes module.

To rename a folder or change entity:

➤ To rename a folder or change entity in the changes tree, select an folder or 
change entity and choose Edit > Rename. Alternatively, right-click the folder 
or change entity and choose Rename. Edit the name and press ENTER.

Impact Strength Description

1-Low Changes that are supported by the SAP application, and 
that have little impact on Quality Center assets. For 
example, inserting or deleting rows in tables.

2-Medium ➤ Changes to objects that have minimal user 
interaction. For example, SAP interfaces.

➤ Changes that are supported by the SAP application 
(for example, screen variants) but may fail Quality 
Center test assets.

➤ Changes to IMG/customization table data.

3-High ➤ Changes to SAP definition objects. For example, 
tables, data elements, views.

➤ Changes to SAP patches.

4-Very High Changes that affect a large functional area or user-
defined transactions.

5-Critical Changes related to ABAP code. This code is not verified 
by SAP.
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➤ To rename an application entity in the Application Model Grid, click the 
name of the change entity and type the new name.

Deleting Folders and Change Entities
You can delete a folder or change entity from the changes tree. When you 
delete a folder, you can choose to delete the folder and its subfolders, or you 
can choose to delete the folder, its subfolders, and change entities.

➤ If you choose to delete the folder with its subfolders, all of the change 
entities are moved to the Unattached folder in the changes tree. 

➤ If you choose to delete a folder with its subfolders and change entities, all 
subfolders and change entities under the selected folder are deleted 
permanently. 

To delete a folder:

 1 From the changes tree, select a folder.

 2 Click the Delete button, or choose Edit > Delete. Alternatively, right-click 
the folder and choose Delete. The Confirm Delete Folder dialog box opens.

 3 Select Delete folders only or Delete folders and changes.

 4 Click Yes.

To delete a change entity:

 1 From the application model tree or Application Model Grid, choose a 
change entity.
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 2 Click the Delete button, or choose Edit > Delete. Alternatively, right-click 
the application entity and choose Delete.

 3 Click Yes to confirm.

Creating Test Sets

To run the tests associated with the application entities impacted by a 
change, you must first create one or more test sets containing the tests you 
want to run. You create test sets in the Testing Impact tab, as part of the 
change impact testing process. You can then run these test sets.

After you have run the test sets, you can analyze the results using 
Quality Center analysis functionality, including graphs, reports, and 
documents. For details on running test sets and analyzing test results, refer 
to the HP Quality Center User Guide. 

To create a test set:

 1 In the Changes module, select the change or change folder for which you 
want to create a test set.

 2 Click the Testing Impact tab. For each application entity impacted by the 
change, the bottom pane displays the tests associated with that entity. You 
can associate tests with an application entity from the Application Model 
module. For more information, see “Associating Application Entities with 
Tests” on page 52.
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 3 Click the Prepare Test Set button. The Prepare Test Set dialog box opens.

 4 From the Test Set Folder box, select the folder in which you want to save the 
test set you are creating. Note that you cannot add a test set directly to the 
Root folder. If you have not created a test set folder for the test set, click 
Cancel and create the folder in the Test Lab module.

 5 In the Test Set Name box, type the name you want to assign the test set.

 6 Under Tests to add to Test Set, select the tests you want to include in the 
test set, or click the Select All button to include all the displayed tests in the 
test set. To invert the order of the tests in the test set, select the tests whose 
order you want to invert and click the Invert Selection button. 
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Tip: You can use filters and cross filters to reduce the number of tests from 
which to select. 

For example, to filter tests associated with business-critical requirements, 
under Cross filter by, select Requirements, and set the appropriate RBQM 
fields. Risk-based quality management enables you to calculate the level at 
which to test each requirement, based on the nature of the requirement and 
the testing resources you have available. 

For more information on working with risk-based quality management, 
refer to the HP Quality Center User Guide. 

 7 Select Go to created Test Set in Test Sets tree if you want to go to the test set 
in the Test Lab module when it is created.

 8 Click Finish. The test set is created in the specified test set folder in the Test 
Lab module. 
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5
Customizing Change Impact Testing

You can customize user group permissions, hide data for a user group and 
customize project entities for Change Impact Testing.

This chapter includes:

 ➤  About Customizing Change Impact Testing on page 77

 ➤  Customizing User Group Permissions on page 78

 ➤  Hiding Data for a User Group on page 82

 ➤  Customizing Project Entities on page 86

 ➤  Customizing Module Access on page 86

About Customizing Change Impact Testing

You can customize entities in the Application Model module and the 
Changes module. You customize these entities in the same way as you 
customize other entities in your Quality Center projects. You can restrict 
which user groups can add, delete and modify folders, change entities, and 
application entities. You can also determine which application entities, 
application entity fields, change entities, and change entity fields each user 
group can view.

In addition, you can add and customize Application Model module and 
Changes module fields and customize access to the Application Model 
module and Changes module.

This chapter describes the additional customization options available with 
Change Impact Testing. For more information on project customization, 
refer to the HP Quality Center Administrator Guide.
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Customizing User Group Permissions

You can customize the permission settings for the Application Model 
module and the Changes Module in the Permission Settings dialog box in 
Project Customization. For more information on user group permissions, 
refer to the HP Quality Center Administrator Guide.

Customizing User Group Permissions for the Application 
Model Module
The Application Model tab displays the tasks available in the Application 
Model module. 
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The Application Model tab includes the following tasks:

Task Description

Add Application Entity User group can add application entities to the 
Application Model module.

Modify Application Entity User group can modify application entities in the 
Application Model module. Note that this task 
enables you to specify the fields that the selected 
user group can modify.

Delete Application Entity User group can delete application entities from the 
Application Model module.

Move Application Entity User group can move application entities in the 
Application Model module.

Add Folder User group can add folders to the Application Model 
Tree.

Modify Folder User group can modify folders in the Application 
Model Tree.

Delete Folder User group can delete folders from the Application 
Model Tree.

Move Folder User group can move folders in the Application 
Model Tree.

Add Link to Asset User group can associate application entities with 
tests and business components.

Delete Link from Asset User group can remove association of application 
entities with tests and business components.
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Customizing User Group Permissions for the Changes 
Module
The Changes tab displays the tasks available for the Changes module. 

The Changes tab includes the following tasks:

Task Description

Add Change Entity User group can add change entities to the Changes 
module.

Modify Change Entity User group can modify change entities in the 
Changes module. Note that this task enables you to 
specify the fields that the selected user group can 
modify.

Delete Change Entity User group can delete change entities from the 
Changes module.

Move Change Entity User group can move change entities in the 
Changes module.

Add Folder User group can add folders to the Changes Tree.

Modify Folder User group can modify folders in the Changes Tree.
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Delete Folder User group can delete folders from the Changes 
Tree.

Move Folder User group can move folders in the Changes Tree.

Add Impact User group can add change impact.

Modify Impact User group can modify change impact.

Delete Impact User group can delete change impact.

Task Description
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Hiding Data for a User Group

You can instruct Quality Center to hide specific application entities and 
application entity fields that a user group can view in the Application Model 
module, and specific change entities and change entity fields in the 
Changes module. 

Hiding Data in the Application Model Module for a User 
Group
You can set filters for specific fields in the Application Model module, 
limiting the application entities that the user group can view. For example, 
you can set the filter for the field Type to SAP Batch Job. This instructs 
Quality Center to allow users belonging to the user group to view only 
application entities that are SAP batch jobs. You set filters in the Filter 
Condition tab in the Application Model Data-Hiding Filter dialog box. For 
more information on hiding data for a user group, refer to the 
HP Quality Center Administrator Guide.

You can filter by the following fields: Code, Entity ID, Entity Name, Folder, 
Is Active, Modified, and Type. For more details on these fields, see “The 
Application Model Grid” on page 44.
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You can also select which fields in the Application Model module the user 
group can see and which should be hidden. You select these fields in the 
Application Model Data-Hiding Filter dialog box, in the Visible Fields tab.

You can choose to hide the following fields: Description, Folder, Is Active, 
Modified, and Type. For more details on these fields, see “The Application 
Model Grid” on page 44.
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Hiding Data in the Changes Model Module for a User 
Group
You can set filters for specific fields in the Changes module, limiting the 
change entities that the user group can view. For more information on 
hiding data for a user group, refer to the HP Quality Center Administrator 
Guide.

You can filter by the following fields: Analysis Date, AUT Client, AUT Code, 
AUT Creation Date, AUT Developer, AUT Released, AUT System Number, 
AUT Target System, AUT URI, Author, Creation Date, Entity Name, Folder, 
Modified, and Status. For more details on these fields, see “The Application 
Model Grid” on page 44.
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You can also select which fields in the Changes module the user group can 
see and which should be hidden. You select these fields in the Changes 
Data-Hiding Filter dialog box, in the Visible Fields tab.

You can choose to hide the following fields: Analysis Date, AUT Client, AUT 
Creation Date, AUT Developer, AUT Released, AUT System Number, AUT 
Target System, AUT URI, Author, Creation Date, Description, Folder, 
Modified, and Status. For more details on these fields, see “The Application 
Model Grid” on page 44.
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Customizing Project Entities

You can customize the system fields and add new user-defined fields for the 
Application Model module and the Changes module from the Project 
Entities page in Quality Center Project Customization. You customize these 
fields under the Application Entity and the Change Entity entities. For more 
information on customizing project entities, refer to the HP Quality Center 
Administrator Guide.

Customizing Module Access

You can customize which user groups can access the Application Model 
module and the Changes module. You customize access to these modules 
from the Module Access page in Quality Center Project Customization. For 
more information on customizing access to Quality Center modules, refer to 
the HP Quality Center Administrator Guide.
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